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About This Guide

The Customizer's Guide provides detailed instructions on how to configure and
customize Arbortext Editor features for use at your site. Examples of typical
customizations are provided throughout the guide to illustrate steps you'll take to
configure Arbortext Editor to address your specific needs. The Customizer's Guide
is a companion to the Programmer's Reference, available in the Arbortext Editor
Help Center.

The information covered in the Customizer's Guide is divided as follows:
*  About This Guide — An introduction to this guide and the information it
COVETS.

*  Custom applications — An overview of implementing custom applications
with PTC Arbortext products.

*  Customizing your site's profiling configuration — Instructions on configuring
and customizing profiling to be specific for your site.

*  Customizing help — Details on how to update PTC Arbortext online help to
be specific to your site.

*  Customizing PDF publishing — Information on configuring and customizing
your site's PDF publishing capabilities.

*  Customizing Publishing Rules — Information on customizing publishing
rules, rule sets, and rule files.

*  Working with XUI (XML User Interface) dialog boxes — Instructions on
creating, displaying, and manipulating dialog boxes in real time by writing and
modifying XML documents.



»  Working with ActiveX controls — Instructions on defining and implementing
ActiveX controls at your site.

*  Merging data from other sources — An overview of the PTC Arbortext data
merging capabilities and references to other sources of information.

»  Working with Arbortext Import/Export — An overview of using Arbortext
Import/Export, configuration instructions, a description of the Arbortext
Import/Export API, instructions on using Arbortext Import/Export in batch
mode, migration information, and troubleshooting information.

*  Customizing copying and pasting from other applications — Details on how to
customize the use of Arbortext Import/Export to paste content from other
applications as tags conforming to a document type.

*  Customizing DITA support — Details on how to customize the Arbortext
Editor user interface for editing DITA documents.

Prerequisite Knowledge

The Customizer's Guide assumes advanced skill using Java, JavaScript, JScript,
VBScript, or COM (Component Object Model). If you're creating an Arbortext
Publishing Engine application, you also need to be familiar with Java servlets,
servlet containers, web servers, the HTTP protocol, and the SOAP protocol.

Arbortext Editor and Arbortext Publishing Engine supporting documentation and
related Javadoc can be found in the Arbortext Editor Help Center. Arbortext
Command Language (ACL) documentation is included in the Help Center, and is
not the focus of the Customizer's Guide.

If you are looking for more general information on programming or scripting
languages, you may want to consult the following resources:

» Thinking in Java, by Bruce Eckel. Published by Prentice Hall PTR.

* Oracle has extensive Java information available at its web site www.oracle.
com/technetwork/java/index.html. The tutorials are especially helpful to
beginners.

» JavaScript: The Definitive Guide, by David Flanagan. Published by O'Reilly
and Associates Inc.

* Mozilla has extensive JavaScript information available at its web site www.
mozilla.org.

* ECMA International (European Computer Manufacturers Association) has the
ECMAScript Language Specification, which is the standard used for
JavaScript, available at its web site www.ecma.ch.

* Microsoft has extensive information about JScript, VBScript, ActiveX
scripting host, and COM available at its web site msdn.microsoft.com.

8 Customizer's Guide


http://java.sun.com
http://java.sun.com
http://www.mozilla.org
http://www.mozilla.org
http://www.ecma.ch
http://msdn.microsoft.com

Custom Applications

Overview of Custom Programs and ScCriptS..........ccouuiiiiiiiiiiiicii e 10
Description of the Custom Directory Structure ..............ooooeiiiiiiiiiiiii e 11
Using the Custom Directory for Custom Applications............c.cccceuieeiiiiiiiii i 22
Description of the Application Directory Structure............cooooiiiiiiiiiii e 23
Using the Application Directory for Custom Applications............ccceevviiiiiiiiiiii e, 26
Deploying Zipped CuStOMIZAtIONS. .........cuuuiiiiiiii e 27
Specifying the JavaScript Interpreter ENgine ............ooiiiiiiiiiiiiii e 29



Overview of Custom Programs and
Scripts

The Arbortext Editor and Arbortext Publishing Engine installations have directory
structures within them where you can place your custom scripts and programs.
The custom and the application directories are described in the following
sections.

The Custom Directory Structure

The Arbortext-path\custom directory has a subdirectory structure
designed to hold your custom programs and scripts and make them automatically
available during the session. At startup, these subdirectories are searched for Java,
JavaScript, JScript, VBScript, ACL, and composer configuration files. You can
also provide custom document types, entities, fonts, graphics, and native shared
libraries and DLLs. The supported file types are automatically accessed if they
reside in the appropriate subdirectory. Implementing your custom files using this
approach takes advantage of the startup sequence to automatically locate your
custom files. The Arbortext-path\custom directory and its subdirectories
are explained in detail in this chapter.

The Application Directory Structure

The Arbortext-path\application subdirectory can contain custom
applications as well as application software distributed by Arbortext. The
application directory must have one or more uniquely named subdirectories,
each containing a specific configuration file, application.xml, that conforms
to a specific format. At startup, the application directory is searched for
subdirectories and the presence of a valid application.xml file. In the
uniquely named subdirectory, all subdirectories of the custom directory are
supported. The custom application in a application then uses these
subdirectories in the same way as the custom directory structure. You can also
have additional subdirectories needed to support the implementation of this type
of custom application. Implementing your custom application using this approach
takes advantage of the startup sequence, supports delivering a completely selt-
contained custom application, and offers the option of setting the conditions for
whether the application should be loaded. The application directory is also
explained in this chapter.
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Description of the Custom Directory
Structure

When Arbortext Editor or an Arbortext PE sub-process starts, it can access custom
files placed in specific directories. At startup, it automatically looks for compiled
Java files (. class and . jar files), JavaScript, JScript, VBScript, ACL,
document type, publishing configuration and other types of files within the
Arbortext-path\customn directory structure.

You can have one or more custom directories outside the Arbortext-path
install tree. To specify a path list for their locations, set the APTCUSTOM
environment variable. The custom directory must be located using a file system;
HTTP references are not supported.

At startup, some search paths are automatically prepended with the path to a
custom subdirectory. Startup automatically sets some of these search paths using
a symbolic variable as a path specification. You can use symbolic parameters to
represent a search path in the context of the default search path, the location of the
install tree, or the locale.

If a directory supports more than one type of file, the file types are processed in
the following order:

* .acl (Arbortext Command Language) files

* .Js (JavaScript or JScript) files

* .class (Java) files

* .vbs (VBScript) files

For each file type, its files are processed in alphabetical order by file name.

The Arbortext-path\custom directory is processed at startup. If you add
custom applications and document types after startup, they're not recognized
during the session. If you're using Arbortext Editor, it needs to be closed and
restarted. If you're using Arbortext Publishing Engine, you need to stop and restart
the Arbortext Publishing Engine to re-initialize the Arbortext PE sub-processes.

custom.xml File

At the top level of the custom directory is the custom. xml file. Following is
the default version of this file:
<?xml version="1.0" encoding="UTF-8"?>
<!--Arbortext, Inc., 1988-2009, v.4002-->
<ApplicationConfiguration
xmlns="http://www.arbortext.com/namespace/doctypes/appcfg">
<Information>
<!--The following name will be shown in the New dialog
as the category for all document types in this
custom directory that do not specify a category.-->
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<Name>Custom Directory Name</Name>
</Information>
</ApplicationConfiguration>

This file is only used when you have a custom document type in the custom\
doctypes subdirectory, and you have not designated a category name for the
document type in the associated document type configuration (.dcf) file’s
NewDialog element. In this case, the name in the custom.xml file’s Name
element is used as the Category name for the document type(s) in the custom\
doctypes subdirectory in the New Document dialog box.

Subdirectory Structure

The following list describes each custom subdirectory and how it's used.
Arbortext Editor and Arbortext Publishing Engine look in these directories for any
references that use a relative path or have no specified path.

12

classes subdirectory
Holds compiled Java .class and . jar files.

TheArbortext Editor and Arbortext Publishing Engine JVM Java class path
holds a list of directories and paths to . jar files. Any files matching * . jar
are prepended to the JVM Java class path. Then the classes parent
directory is prepended, putting it first in the JVM Java class path.

In cases where a class file occurs in more than one . jar file, you can extract
the preferred . class file from its . jar file and place it in a subdirectory
path of the classes directory to control which one takes precedent.

composer subdirectory

Holds publishing configuration files (. ccf, .ent, and .xml files) and can
support a catalog file. Supports one level of subdirectories.

The default path is Arbortext-path\composer. If there are any
subdirectories of the custom\ composer directory, those subdirectories are
prepended to the publishing configuration path. Then the custom)\
composer parent directory is prepended to the path. If the custom\
composer directory contains a catalog file, that directory is also
prepended to the catalog path.

datamerge subdirectory

Holds data merge configuration (. dmf) files specifying queries and their
components. The . dmf file structure is discussed in the Customizer's Guide.

dialogs subdirectory

Holds dialog files that can be accessed from custom applications, such as one
that uses the AOM Application.createDialogFromFile method.
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The Arbortext-path\samples\XUI\preferences\pref
exts.zip contains a sample application that adds a tab to the Preferences
window as a way to extend preferences for custom applications. Refer to the
readme. txt file for more information.

If there are any subdirectories of the custom\dialogs directory, those
subdirectories are prepended to the dialog path. Then the custom\dialogs
parent directory is prepended to the dialog path.

ditarefs subdirectory

Holds content referenced by DITA documents when the reference is not
specified as either an absolute path name or a path name relative to the current
document directory. For example, the ditarefs subdirectory could hold
content referenced by topic references, content references, and so forth.
Supports one level of subdirectories.

The default DITA reference path is Arbortext-path\ditarefs. The
DITA references path can be set in the File Locations category of the Tools »
Preferences dialog box. You can also use the set ditapath option or the
APTDITAPATH environment variable to set the default path for DITA
references. If there are any subdirectories of the custom\ditarefs
directory, those subdirectories are prepended to the path. Then the custom\
ditarefs parent directory is prepended to the path.

~ Note

Graphic references from DITA documents are resolved using the graphics
path list.

dictionaries subdirectory

Holds user-defined dictionary files that can be used by the spelling checker.
Supports one level of subdirectories.

The default path is Arbortext-path\lib\proximity\userdict. If
there are any subdirectories of the custom\dictionaries directory,
those subdirectories are prepended to the dictionary path. Then the custom)\
dictionaries parent directory is prepended to the dictionary path.

doctypes subdirectory

Holds a custom catalog file and document type files. Supports one level of
subdirectories. Each document type should reside in a uniquely named
subdirectory of doctypes. The subdirectory should also contain a catalog
file for the custom document type. A doctypes subdirectory can also
contain a subset of the complete document type file set. You can place a
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document type configuration file . dcf or stylesheets ina \custom)\
doctypes\doctype directory.

You can add a stylesheet to the list of stylesheets that displays when you make
a publishing request using one of the File » Publish choices. Arbortext Editor
and Arbortext Publishing Engine search each \custom\doctypes\
doctype directory and aggregate the list of stylesheets. For example, you
can add stylesheets for the asdocbook built-in document type (asdocbook)
by placing them in Arbortext-path\custom\doctypes\
asdocbook.

If a document does not specify an Editor view stylesheet with a stylesheet
association PI, Arbortext Editor will first search first the document directory,
then the relevant \custom\doctypes\doctype directory, and finally the
original location for the doctype directory.

If the subdirectory contains only a . dcf file, it must conform to a naming
convention that expects the subdirectory and . dcf file name to reflect the
base document type name. For example, you could customize the default
asdocbook asdocbook.dcf file, and put it in Arbortext-path\
custom\doctypes\asdocbook\asdocbook.dcf to override the
built-in . dcf. Note that the document type subdirectory and file name must
be the same as the default document type name for Arbortext Editor and
Arbortext Publishing Engine to find all the relevant document type files.

A DCEF file can reference other files, such as the . pcf, demo.xml, and
template.xml files. Custom versions of these files can be placed with the
.dcf in \custom\doctypes\doctype. If Arbortext Editor and
Arbortext Publishing Engine find a . dcf in the \custom\doctypes\
doctype location, relative path references are resolved by first searching the
same directory as the . dcf and then by searching the document type directory
in the original location.

The default catalog path is Arbortext-path\doctypes. If there are any
subdirectories of the custom\doctypes directory that contain a catalog
file, those subdirectories are prepended to the catalog path. Then the
custom\doctypes parent directory is prepended to the catalog path.

You can place custom tag template files (. tpl)ina custom\doctypes\
doctype\tagtemplates directory. The custom\tagtemplates
directory can also be used as a more generally available location for tag
templates.

Any document type from the custom\doctypes directory is also added to
the list of available document types that are displayed in the File » New dialog
box.

entities subdirectory
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Holds file entities. Supports one level of subdirectories.

A file entity is any structurally complete document unit saved as a file. File
entities commonly have an . xm1 file extension.

The default entity path is Arbortext-path\entities. If there are any
subdirectories of the custom\entities directory, those subdirectories are
prepended to the entity path. Then the custom\entities parent directory
is prepended to the entities path.

fonts subdirectory
Holds custom AFM or TFM font metric files (. afm and . t fm).

The default fonts path is Arbortext-path\fonts. If there are fonts in
custom\ fonts, the path is prepended. If the APTTEXFONTS environment
variable is set, the custom\ fonts directory is prepended to it.

formats subdirectory
Holds custom PubTex format files (. fmt).

The default PubTex format path is Arbortext-path\formats. If there
are . fmt files in custom\ formats, the path is prepended. If the
APTTEXFMTS environment variable is set, the custom\ formats directory
is prepended to it.

framesets subdirectory

Holds custom framesets for Publish » For Web. Supports one level of
subdirectories. Framesets are defined in the document type configuration file.

The default frameset path is Arbortext-path\framesets. If there are
any subdirectories of the custom\ framesets directory, those
subdirectories are prepended to the framesets path. Then the custom)\
framesets parent directory is prepended to the frameset path.

graphics subdirectory
Holds graphic files. Supports one level of subdirectories.

The default graphics path is Arbortext-path\graphics. If there are
any subdirectories of the custom\graphics directory, those subdirectories
are prepended to the graphics path. Then the custom\graphics parent
directory is prepended to the graphics path.

importexport subdirectory
Holds Arbortext Import/Export Import project files.
inputs subdirectory

Holds source files for custom macros, program fixes, or other customizations
in a custom. tmx. Refer to Using . tmx files for more information.
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Document type and document . tmx files can be placed in the custom)\
doctypes directory.

Also holds . tex files and source files for hyphenation exception and pattern
rules in .exc and . pat files.

The default source path is Arbortext-path\inputs. Then the
Arbortext-path\custom\inputs directory is prepended to it.

1ib subdirectory

Holds custom versions of the . pdfcf PDF configuration file. The default
path for .pdfcf filesis Arbortext-path\1lib. Thenthe Arbortext-
path\custom\1lib directory is prepended to it. For more information on
creating . pdfcf files, refer to the Customizer's Guide.

In addition, the 1ib subdirectory can hold . wcf files for custom window
classes. For more information on creating . wc £ files for window classes, refer
to the Creating custom window class preferences files in the Arbortext Editor
help.

The 1ib subdirectory can also hold custom versions of the following files:
charent.cf
charmap.cf
installprefs.acl
prted.pro
pubview.cf
pubview. fnt
tfmfont.cf
tfmscaling.cf
tfontsub.cf
wcharset.cf
wfontsub.cf
xcharset.cf
xfontsub.cf

You can specify more than one charent . cf file, as the effects are
cumulative. Refer to the Setting paths for new character set files and
APTCUSTOM environment variable topics in the online help for more
information.
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The custom\ 1ib directory also has 1ocale\locale—-name
subdirectories. The default path is the appropriate locale subdirectory of
Arbortext-path\1lib\locale. The locale-specific subdirectory of the
custom\1lib\locale directory is prepended to the default locale path.

The 1locale\ locale—-name can hold custom versions of the .pdfcf PDF
configuration file. For more information on creating . pdfcf files, refer to the
Customizer's Guide.

Each 1ocale\ locale-name directory can hold custom versions of the
following files:

charent.cf
installprefs.acl
ixlang.cf
pubview.cf
pubview. fnt
tfmfont.cf
tfmscaling.cf
tfontsub.cf
wcharset.cf
wfontsub.cf
xcharset.cf
xfontsub.cf

The custom\1ib directory also has a subdirectory to hold native shared
libraries for platform-specific use:

0 dll
Holds Windows dynamic link libraries, or DLL files (.d11).

The path to this directory is prepended to the system PATH environment
variable.

The custom\1ib directory can have an ix1lang subdirectory, which holds
a custom ixlang.cf file and index mapping files like those found in
Arbortext-path\lib\ixlang.

publishingrules subdirectory

Holds publishing rules .prcf files which contain definitions of publishing
rules and publishing rule sets.

pubview subdirectory
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Holds pubview.cf and pubview. fnt files.

The default path is Arbortext-path\pubview. Then the Arbortext-
path\custom\pubview directory is prepended to it.

scripts subdirectory

Holds . ac1l (Arbortext Command Language), . vibs (VBScript), and . js
(JavaScript and JScript) files. Supports one level of subdirectories.

The scripts in this directory can be called from scripts or applications in the
custom\init directory, which is processed at startup time. Scripts placed
here can be accessed using the source or require ACL commands. A
customized menu item or button can call a script in custom\scripts when
invoked.

If there are any subdirectories of the custom\scripts directory, those
subdirectories are prepended to the load path. Then the custom\scripts
parent directory is prepended to the load path.

stylermodules subdirectory

Holds Arbortext Styler stylesheet modules. Any modules stored in this
directory are automatically available to Arbortext Styler.

tagtemplates subdirectory

Holds . tpl files. You can also put custom tag templates you want associated
with a particular document type into a custom\doctypes\doctype\
tagtemplates directory or in the original location of the document type's
doctype\tagtemplates directory.

If the user clicks the New button from the Tag Templates dialog box, Arbortext
Editor will use the first directory with write access for that user in the tag
template path.

If the APTTAGTPLDIR environment variable is set, this path is prepended to
it.

init subdirectory
Holds .acl, .Js, .class, and . vbs files.

The init subdirectory is processed last at startup time. All files of the
supported application types are executed. No nested subdirectories of
custom\init are supported. This directory is processed after the other
Arbortext-path\custom subdirectories so that its scripts and
applications can rely on paths already established during startup.

If you are putting custom applications on the Arbortext PE server, use the
init directory for your custom .acl, .js, .class files.
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In the startup process, the custom\init directory is processed after
~main.acl but before arbortext.wcf. See the online help topic Startup
command files for complete startup processing information.

The supported application types are:
0 .acl (Arbortext Command Language) files

Errors are reported to Arbortext Editor or recorded by Arbortext
Publishing Engine to be sent to its HTTP client.

O . js (JavaScript or JScript) files

Errors are reported to Arbortext Editor or recorded by Arbortext
Publishing Engine to be sent to its HTTP clients. You need to specify the
JavaScript interpreter engine to use in processing . j s files. Refer to
Specifying the JavaScript Interpreter Engine on page 29 for more
information.

O .class (Java) files

Java . class files in this directory must be compiled Java classes that are
not part of a named package. You can also put a .class file in custom\
init that calls into a . jar file located in the custom\classes
directory.

The Java class must also implement a public static void

main (String[] args) method, which will be called with an empty
string array. If the . class file does not implement this method, an error
is reported to Arbortext Editor or recorded by Arbortext Publishing Engine
to be sent to its HTTP client.

o .vbs (VBScript) files

Errors are reported to Arbortext Editor.
editinit subdirectory

Holds .acl, .js, .class, and . vbs files. Note that when you run
Arbortext Editor with the —c option, any applications in this subdirectory are
not executed at startup.

All files of the supported application types are executed each time a non-
ASCII document is opened for editing. Files in this directory act on a
document opened in the Edit window. File in this directory act on a document
opened using ACL when the 0x8000 flag is used with the doc_open
function. File in this directory act on a document opened using AOM when the
OPEN EDITINIT flag is used with the Application.openDocument method.

The editinit subdirectory is processed before any document type
command files, document type instance command files, and document
command files.
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The supported application types are:

O

.acl (Arbortext Command Language) files

Errors will be reported if the interface is running interactively, otherwise
they will be suppressed.

. Js (JavaScript or JScript) files

Errors will be reported if the interface is running interactively, otherwise
they will be suppressed.

.class (Java) files

Java . class files in this directory must be compiled Java classes that are
not part of a named package. The Java class must also implement a
public staticvoidmain (String[] args) method, which is
called with an empty string array. You can puta .class file in custom)\
init thatcalls into a . jar file located in the custom\classes
directory. Errors will be reported if the interface is running interactively,
otherwise they will be suppressed.

.vbs (VBScript) files

Errors will be reported if the interface is running interactively, otherwise
they will be suppressed.

Error Reporting for the custom\init Directory

Errors caused by mistakes in custom code in the Arbortext-path\custom\
init directory are reported with both the error message and the name of the
initialization file causing the error. Note the following:

If Arbortext Editor is not running interactively (batch mode), no errors are
reported and the errors are not logged.

Arbortext Publishing Engine records errors and reports them to its HTTP
clients in an HTML error page.

ACL, JavaScript, and Java class errors are reported to the Arbortext Editor
interface or held by Arbortext Publishing Engine to be sent to HTTP clients
making requests.

Additional Information

If you are using the AOM, refer to the documentation for
Application.getCustomDirectory. Refer to XUI Overview on page 114
for information on extending the Arbortext Editor Preferences dialog box for your
custom application.
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The following set command options and environment variables affect custom
path search lists. They are documented in the online help.

set catalogpath
set composerpath
set dialogspath
set ditapath

set entitypath
set framesetpath
set graphicspath
set javaclasspath
set libpath

set loadpath

set pdfconfigfile
set tagtemplatepath

set userdictpath

Related Topics

» Using the custom directory for custom applications on page 22
* Description of the application directory structure on page 23
» Startup command files

* The following set command options and environment variables affect
custom path search lists:

O set catalogpath

O set composerpath
© setdialogspath

O setditapath

O setentitypath

O set framesetpath
O set graphicspath
O set javaclasspath
O set libpath

O set loadpath
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O setpdfconfigfile
O set tagtemplatepath
O set userdictpath

O APTTEXFONTS environment variable

For information on creating and implementing custom applications, see the
Programmer's Reference and the Customizer's Guide.

If you are using the AOM, refer to the documentation in the Programmer's
Reference for Application.getCustomDirectory.

Refer to XUI Overview on page 114 for information on extending the Arbortext
Editor Preferences dialog box for your custom application.

Using the Custom Directory for Custom
Applications

The Arbortext-path\custom subdirectory structure provides the means to
implement custom applications. Where your application should be placed depends
on the application purpose and programming language.

If you're implementing custom applications or scripts, the following information
will assist you in determining the approach and location for your files:

* A custom Java program can be placed in custom\init, which supports a
. class file that must implement a public static voidmain
(String[] args) method. The method will be called at startup with no
arguments (an empty St ring array). If an error occurs, it's reported
interactively for Arbortext Editor or sent to the HTTP client for the Arbortext
Publishing Engine.

A custom Java program can also be placed in custom\classes, which
supports .class or . jar files.

We recommend putting Java applications in the custom\classes directory
and calling or initializing them from the custom\init directory.

Paths to . jar files in custom\classes are automatically prepended to the
embedded Arbortext Editor Java class path. Then the path to custom\
classes is prepended, putting it first in the search order.

* A custom JavaScript, JScript, VBScript, or ACL application can be placed in
custom\init orin custom\scripts. If you place your scripts in the
custom\scripts directory, you can call them from a script or scripts you
place in custom\init (which is processed at startup). Any code that exists
outside a function definition in a script from custom\init is executed at
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startup time. Errors are reported if running interactively, otherwise they're
suppressed.

You can create a simple JavaScript example file called simple init.js. The
script should contain the following line:
Application.alert ("Hello from JavaScript");

Putthe simple init.js filein Arbortext-path\custom\init.

When the startup process loads scripts from custom\init, you will see a dialog
box showing the Hello from JavaScript message.

Description of the Application Directory
Structure

The Arbortext-path\application subdirectory supports installing an
application into the Arbortext Editor and Arbortext Publishing Engine install
trees. Arbortext Editor and the Arbortext Publishing Engine automatically search
for subdirectories of the application directory at startup.

Arbortext-path\application must contain a uniquely named
subdirectory for each distributed application. Arbortext recommends using the
naming pattern for a unique qualified Java class name:
com.company-name.application-name

Each unique subdirectory of the application directory must also contain an
application.xml configuration file which describes various aspects of the
application, such as its release version and supported versions of Arbortext
products. At startup, Arbortext Editor and the Arbortext Publishing Engine search
the application directory for any subdirectories containing an
application.xml configuration file. The application.xml file contents
provide the criteria to determine whether the application should be loaded. The
application directory must be located using a file system; HTTP references
are not supported.

Subdirectory Structure

A subdirectory of the application directory can be structured the same as the
custom directory to take advantage of automatic Arbortext Editor and Arbortext
Publishing Engine startup processes. For example, if the uniquely named directory
contains graphics or entities directories, those directories are
automatically added to the search paths constructed at startup.

An application path could be something like:
application\com.company-name.application—-name

Refer to the Description of the custom directory structure on page 11 for the
names and descriptions of each supported subdirectory.
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~ Note

When Arbortext Editor or the Arbortext Publishing Engine constructs search
paths, subdirectories of the custom directory take precedence over any
corresponding subdirectories under the application directory. When
search lists are constructed at startup, the first path in any search list will be
the appropriate custom directory followed by any applicable directory under
the application directory. For example, in constructing the graphics
search path list at startup, custom\graphics would precede
application\com.arbortext.sample\graphics. An
application\graphics directory with no application.xml file
will be ignored during startup.

When implementing a custom application using the application directory
structure, you can add supplemental directories as needed to support your
application. However, your application code must be aware of these directories
and how to use them.

Application Startup File

The Arbortext-path\doctypes\appcfglapplication.xml file

provides a basic template for defining information about the custom application.

You can make a copy of doctypes\appcfg\application.xml touse asa

template to create the file that will eventually be distributed with the application.

The application.xml file must be placed in the application's top level

directory, for example:
Arbortext-path\application\com.company.application-package-name\application.xml

In the template application.xml file, you can specify a list of elements that
describe the application. If the custom application determines its criteria is not met
and the application is not to be loaded, then these values are ignored. The base
element for the file is the ApplicationConfiguration element. This
element has a required attribute called installType that determines the type of
Arbortext Editor installation for which this application is supported. The default
value is any meaning the application is supported in both the full and compact
installations of Arbortext Editor. The other supported value is full meaning the
application is only supported in the full installation of Arbortext Editor.

The following other elements are supported in the application.xml file:
* Name (required)

* Description

* LicenseNumber is only for an application distributed by Arbortext

* Version (required)
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* Date
* Copyright
* Vendor

* RequiredApplications is for other applications that are required for
this application to run correctly. You must enter the qualified name for the
application in the qualifiedName attribute and a human-readable name in the
name attribute.

* SupportedProducts

A Product element has attributes for specifying the name (required),
minimum version (required), and maximum version of the Arbortext product
that supports the custom application or application. The Product
specification helps the launching Arbortext product determine whether it
should load this custom application by matching criteria specified in this
section.

The name must be one or more of the following:
O Arbortext Editor

O Arbortext Publishing Engine

O  Arbortext Architect

O Arbortext Editor with Styler

The version must follow the convention used by Arbortext products, such as
5.2,5.2 M040, or 5.3.

* SupportedPlatforms

The section is reserved for future use. Windows is currently the only supported
platform.

* GlobalParameters

Parameter contains ParameterName and ParameterValue elements
for specifying any global variables that the application may need when it's
launched.

Related Topics

If you are using ACL, refer to the following ACL function descriptions:

* application name function
* get custom dir function

* get custom property function
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* get user property function
* set user property function

If you are using the AOM, refer to the documentation for
Application.getCustomDirectory. Refer to XUI Overview on page 114
for information on extending the Arbortext Editor Preferences dialog box for your
custom application.

The following attributes from the Application interface are also useful:

* haveWindows

* 1initDone

e 1isE3

* customProperties
* userProperties

* name

Using the Application Directory for
Custom Applications

The Arbortext-path\application subdirectory provides the means to
implement a custom application that uses a special configuration file to determine
whether it should be loaded at startup. The application directory uses the
same principles of structure as the custom directory.

The Arbortext-path\application directory is processed at startup. If
you add a custom application after startup, you must exit and restart Arbortext
Editor or stop and restart the Arbortext Publishing Engine to have it recognized.
You also have the option to issue the f=init function to re-initialize the
Arbortext PE sub-processes. Refer to Configuration Guide for Arbortext
Publishing Engine for more information.

Rules for using the application directory are:

*  Your custom application must be contained in a uniquely named subdirectory
of the application directory.

* You must have an application.xml configuration file in the uniquely
named subdirectory that sets the conditions for loading the application.

» The same set of subdirectories supported by the custom directory are
supported for the uniquely named subdirectory of the application
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directory. At startup, the supported directories are automatically detected and
used in constructing search paths.

* Any other subdirectory of the application directory will be ignored at
startup. For example, an application\graphics subdirectory with no
application.xml file will be ignored during startup.

Arbortext has developed proprietary custom applications that are deployed using
the application subdirectory structure. A uniquely named subdirectory
contains all the necessary components to run an application within Arbortext
Editor as well as the Arbortext Publishing Engine.

The following information will help determine an approach for a custom
application.

* You can have additional subdirectories for your custom application. You are
not limited to the subdirectories supported by the custom directory.
However, these additional directories are not automatically recognized during
the startup process.

* Processing each unique application's subdirectories follows the same rules for
processing custom subdirectories. Recall that the application's subdirectories
come after the custom subdirectories in constructing any applicable search
paths for the session.

» If you decide not to use a particular supported subdirectory, you can improve
performance by omitting the directory to reduce the length of a search path
that would contain it.

* You can use the APTAPPLICATION environment variable to set the path to
one or more application directories.

* An application should not write data to its own application directory. An
application user may not have write permission access to this application
directory, for example, any C: \Program Files directories on Windows
(the location where Arbortext Editor and the Arbortext Publishing Engine are
typically installed).

Deploying Zipped Customizations

You can deploy not only custom directories, but also application and
content management system adapters directories in a compressed zip file. Using a
zip file to distribute your customizations has the following advantages:

* You can host your customizations on a web server.
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In this case, use the HTTP or HTTPS URL to the zip file as the value for the
APTCUSTOM environment variable.

*  Your customizations will be available to users when they cannot access your
network.

If you use a shared network folder to host your customizations, users do not
have access to those customizations when the network is unavailable. If you
use a zip file to distribute your customizations, Arbortext Editor unzips those
customizations to a directory in the Arbortext Editor cache directory
(.aptcache\zc). At start up, Arbortext Editor checks to see whether the
zip file has been updated. If it has, Arbortext Editor downloads and
uncompresses the updated customizations. If not, Arbortext Editor continues
to use the customizations stored in the local cache. If the network is
unavailable to a user, your customizations are still available to that user in the
local cache. Note that the user must also have a fixed Arbortext Editor license
on their system to work away from the network.

* Network traffic might be reduced.

Since the zip file containing your customizations is only downloaded once
over the network, and then only if it has been updated, traffic on your network
might be reduced. If you store your unzipped customizations in a shared
network folder, Arbortext Editor might have to access that folder several times
over the course of a session.

* Customizations stored in a compressed zip file are harder to change
accidentally than customizations stored in a directory structure.

Note that you cannot use a zip file to distribute a customized
installprefs.acl inthe custom\1lib directory. You can use the
APTINSTALLPREFS environment variable to specify the location of a custom
installprefs.acl file.

Note also that you cannot include the following font configuration files in the 1ib
subdirectory of a zipped custom directory:

e charent.ct
* wcharent.cf
* wfontsub.cf
* charmap.ct

These files are processed before a zipped custom directory when Arbortext
Editor starts up, so the files cannot be processed when deployed in that way.
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Specifying the JavaScript Interpreter
Engine

Both JavaScript and JScript files have a . js file extension. By default, Arbortext
Editor and the Arbortext Publishing Engine interpret . js files as Rhino
JavaScript files. You should specify the JavaScript interpreter for a JavaScript or
JScript . js file. This is especially important if you have . js files of both types.

We recommend adding a comment line to your script that specifies either the
Rhino JavaScript engine (the default) or the Microsoft JScript engine as shown in
the following examples. The first line of your . js file must be a comment
starting with / /.

To specify the Rhino JavaScript interpreter:
// type="text/javascript"

To specify the Microsoft JScript interpreter:
// type="application/jscript"

The specification can be enclosed in a script tag. Both of the following examples

are a valid specification for JScript:
// <script type="application/jscript">
// type="application/Jjscript"

You can also specify the JavaScript interpreter using the ACL set
javascriptinterpreter command. You can specify it in an ACL file
placed in the Arbortext-path\custom\init directory, where it will be
processed at startup. For information on setting the interpreter using ACL, see the
online help topic for set javascriptinterpreter.
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Customizing Your Site's Profiling
Configuration

Profiling sections of documents let you designate that certain sections contain
information targeted at a specific audience or contain information that only applies
when a particular set of circumstances exists. This chapter describes how to
configure profiling specific to your site’s needs.

Profiling Overview

Profiling is a means to provide specific content for a selected audience or for a
specific application. Using profiling, authors can include all document variations
in one file, and use profiles to control what elements appear in published versions
of a document. By comparing the selected audience with each element's audience
profile, Arbortext Editor strips out irrelevant content and assembles a custom
publication.

Individual profiles specify that content can have one or more than one profile of a
particular class. Classes may contain standard and unique profiles.

» Standard individual profiles apply one or more profiles in a class to an
element.

* Unique individual profiles apply one and only one profile in a class to an
element.

Two types of profile groups exist. Apply profile groups specify a collection of
individual profiles defined as a named profile group an author can apply to an
element in a single step. Set profile groups specify a collection of individual
profiles an author can choose at publishing time in a single step.

Authors apply profile values to elements at editing time by setting certain element
attributes to specific values as defined in profile configuration (. pcf) files.
Individual document types reference the . pcf file containing the profiling
definitions defined for the document type. Multiple document types can reference
a single . pcf file.

You can configure colored shading to differentiate between profile, profile groups,
or individual values. Refer to Using shading for profiled elements for further
information.

32 Customizer's Guide


help27680.html

.pcf (Profile Configuration File)

A profile configuration file (. pcf) is an XML document specifying profile values
that can be applied to any elements (or a limited number of elements) in a
document type. A document type's . dcf file specifies the . pcf file to use for the
document type's profiling configuration. Several document types can use the same
.pcf file for their profiling configurations.

A .pcf file has the following structure:

A top-level <Profiles> element contains all of the <ProfileClasses>
elements in the configuration file.

<ProfileClasses> elements define the profile classes of related
individual profiles and groups of individual profiles for applying at editing
time and setting at publishing time. <ProfileClasses> elements contain
the <Profile>, <ApplyProfileGroup>, and <SetProfileGroup>
elements.

If you are working with profile shading, you can set a value for the
conflictShadingBackground attribute for a <ProfileClasses> element to
provide a conflict color. This color will be applied to an element in a
document if it has been assigned multiple profile values, each configured with
different shading colors.

-~ Note

Although it is possible to specify a conflict color on any
<ProfileClasses> element in the profile configuration file (.pcf),
the color must be defined on the first <ProfileClasses> element to
be effective.

<Profile> elements define individual profiles that authors can apply to
elements at editing time and select to produce profiled output. With the
<Profile> element, you can specify:

O The specific elements to which the profile is restricted

O The specific elements from which the profile is restricted

O Sub classes, or folders, of related profiles

o Allowed values for the profile

O That the profile is restricted to one and only one profile value

© Shading colors
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Set the shadingBackground attribute for the whole profile (Profile
element), a profile sub-category (ProfileFolder child element), or a
profile’s individual values (A1 1owed child element)

<ApplyProfileGroup> elements specify groupings of individual profiles
the author can apply to elements at editing time.

<SetProfileGroup> elements specify groupings of individual profiles the
author can set at publishing time. Individual profiles can be included and
excluded using logical expressions.

Configuring Profiles

This section covers the profile configuration process and provides examples of
profile configurations.

Configuration Process

Before actually configuring your profiling, determine the proper profiles to create
for your site. Consider the following items:

Create profiles so that your biggest possible audience does not require that any
profiles are applied. This will cut down on the time needed to profile a
document.

Determine whether it will be more work to profile a document to include
elements or exclude elements. It may create less work for authors if you create
a NOT Model 123 profile instead of a Model 123 profile.

Avoid creating profiles that are subsets of one another. For example, in the
Security profile class, do not create a general Employees profile and
specific Managers and Trainees profiles. This may cause problems for
those applying the profiles. Instead of creating the general Employees
profile, create the Managers and Trainees profiles.

Use the following procedures to create or update a profiling configuration file.

Specifying the .pcf File to Use

1.

34

Using Arbortext Architect or Arbortext Editor, open the . dcf file of the
document type for which you want to configure profiles.

Locate the Profiling element. If the file doesn't include a Profiling
element, add one.

Place your cursor next to the Profiling element and choose Edit » Modify
Attributes. Enter the name of the . pcf file containing the profiling

configuration you want to use with this document type and choose OK. (If the
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4.

.pcf file is not in the same directory as the . dcf file, enter the full path and
file name of the . pcf file.)

Save the document and close Arbortext Architect or Arbortext Editor.

Configuring the Profiles

1.

Using Arbortext Architect or Arbortext Editor, open the . pcf file in which
you want to configure profiles.

If this is a new (empty) . pcf file, add the top-level Profiles element.

Profiles are categorized within ProfileClasses elements that define the
profiles elements can have. Create a new ProfileClasses element. A
child Profile element is automatically created and you are prompted to edit

the Profile element's attributes. (You must have the Edit » Force Required
Attributes Entry preference selected for the Modify Attributes dialog box to

open automatically.)

Type a descriptive name for the attribute in the alias field. This is the profile
name that will appear in Arbortext Editor profiling dialog boxes for assigning
profiles and publishing documents.

Type a valid attribute name in the attribute field. You must specify a common
attribute that can appear on every element in the DTD, and it must have a
declared value of CDATA.

Choose OK to create the profile.

Define the allowed values this profile can have by placing the cursor next to
the Profile element and inserting a child A11owed element and value
attribute for each possible value.For example, if you specified the os attribute
of the Profile element, you might want to specify values of Windows and
UNIX for the value attributes of two Al1lowed elements.

Repeat the previous steps to configure additional profile classes.

When you've completed adding profiles to the configuration file, save and
close the . pcf file.

Configuring Profile Shading

1.

Using Arbortext Architect or Arbortext Editor, open the . pcf file in which
you want to configure profiles.

Locate the Profile element for which you wish to set shading. You can
choose to set a shading color for the whole profile (Profile element), a
profile sub-category (ProfileFolder child element), or for a profile’s
individual values (A1 1owed child element).

Place your cursor next to the element for which you wish to set shading, and
choose Edit » Modify Attributes.
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4. In the Modify Attributes dialog box, select a color value for the
shadingBackground attribute.

Choose OK to exit the dialog box.

6. Locate the ProfileClasses element for which you wish to provide a
conflict color.This color will be applied to an element in a document if it has
been assigned two profile values, each configured with different shading
colors.

~ Note
Although it is possible to specify a conflict color on any
<ProfileClasses> element in the profile configuration file (. pcf),
the color must be defined on the first <ProfileClasses> element to
be effective.

7. Choose Edit » Modify Attributes. In the Modify Attributes dialog box, select a
color value for the conflictShadingBackground attribute.

Choose OK to exit the dialog box.

When you've finished configuring profile shading, save and close the .pcf
file.

Profiling Configuration Examples

A sample . pcf file accompanies the sample axdocbook template. The . pcf file
is stored at Arbortext-path\doctypes\axdocbook\axdocbook.pct.
Several of the following examples are included in axdocbook.pcf.

Nesting Profiles

Profile classes can contain folders containing more folders and profiles. Using
such a structure provides a categorization of related profiles. In this example,
several Windows platforms are categorized in a parent Windows folder.

- £3 Cperating System
-0 03 Windows
O windows XP
O Windows 2000
Oy vwindows Server 2003

O Unix
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- 03 Qperating System
=[] £ Windoms
O Es windows XP
O Es windows 2000
O Ey windows Sarver 2003

O Unix
Example of nested profiles in the Apply Profiles dialog box.

This profiling configuration is created with the following markup:
<Profile attribute="os" alias="Operating System">
<ProfileFolder name="Windows">

<Allowed value="Windows XP"/>

<Allowed value="Windows 2000"/>

<Allowed value="Windows Server 2003"/>
</ProfileFolder>

<Allowed value="Unix"/>

</Profile>

Restricting Profiles to or from Specific Elements

By restricting profiling to only certain elements, you can ensure that information
is always included or included in only certain circumstances. In this example, if
the toc element has a role attribute set to the value required, the element
cannot be profiled by the users level of expertise. This ensures that the Table of
Contents is always included when the document is published. If the user attempts
to profile a toc element with its role attribute set to the value required, the
profiles will be unavailable:

- [3 User Level
& Mowice
@ Typical
& Expert

= (3 User Level
& Mowice
& Typical
& Expert

Example of restricted profile values.

This profiling configuration is created with the following markup:
<Profile attribute="userlevel" alias="User Level">
<NotProfileElement element="toc">

<AttributeTest name="role" value="required"/>
</NotProfileElement>

<RadioChoice>

<Allowed value="Novice"/>

<Allowed value="Typical"/>

<Allowed value="Expert"/>

</RadioChoice>
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</Profile>

Using Logical Expressions when Configuring Profiles

Set profile groups define a collection of individual profiles an author can choose
at publishing time in a single step. When creating set profile groups, you can use
logical expressions to specify publishing that is dependant on profile value
relationships. When using logical expressions, ensure that the names assigned to
the SetProfileGroup elements clearly communicate to the user the profiles that
will be published.

In this example, different user levels are grouped. Elements profiled for all of the
user levels represented by the selected group will be published.

- 2 Set Profile Groups
O By Movice and Typical User Levels
O By Expert and Typical User Levels
O By Typical wWindows Customer

--[] 3 Set Frofle Groups
O By Movice and Typical User Levels
O By Expert and Typical User Levels
O By Typical windows Customer

Example of set profile groups.

This profiling configuration is created with the following markup:
<SetProfileGroup name="Novice and Typical User Levels">
<LogicalExpression>

<LogicalGroup operator="OR">

<ProfileRef alias="User Level" value="Novice"/>
<ProfileRef alias="User Level" value="Typical"/>
</LogicalGroup>

</LogicalExpression>

</SetProfileGroup>

<SetProfileGroup name="Expert and Typical User Levels">
<LogicalExpression>

<LogicalGroup operator="OR">

<ProfileRef alias="User Level" value="Expert"/>
<ProfileRef alias="User Level" value="Typical"/>
</LogicalGroup>

</LogicalExpression>

</SetProfileGroup>

<SetProfileGroup name="Typical Windows Customer'">
<LogicalExpression>

<LogicalGroup operator="AND">

<ProfileRef alias="User Level" value="Typical"/>
<LogicalGroup operator="OR">

<ProfileRef alias="Operating System" value="Windows XP"/>
<ProfileRef alias="Operating System" value="Windows 2000"/>
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<ProfileRef alias="Operating System" value="Windows Server 2003"/>

</LogicalGroup>

<ProfileRef alias="Security Level" value="Customer"/>
</LogicalGroup>

</LogicalExpression>

</SetProfileGroup>

Profiling API

Profiles are organized into folders and sub-folders containing one or more profile
values. You can visualize the resulting structure as a tree of information, with each
profile (along with its folders, sub-folders, and allowed values) being a branch of
the tree. Each folder, sub-folder, or value is considered to be a node (or
profilenode) on the tree. The profile tree is a hierarchical structure containing
profilenode objects and branches that link the different profilenodes
with each other. Each branch has a top-level root node with sub-folder nodes (if
any) and value nodes that represent the leaves of the tree.

The profiling API consists of ACL functions that walk a profile tree and traverse
the profilenodes to determine the following information:

« The different properties of each profilenode. (For example, to determine
the type of node the profilenodeis.

* Relative location information about the profilenode such as the node's
ancestors, children, and so on.

A profilenode can be one of the following types:

« STANDARD PROFILE, RADIO PROFILE or FOLDERED PROFILE —
The type assigned to the top-level (root) profilenode.

A profile is of type RADIO_PROFILE if takes on radio choices as allowed
values (unique profiles). A profile is of type FOLDERED PROFILE if it
contains folders. Otherwise, the profile is of type STANDARD PROFILE.

« PROFILE FOLDER
« ALLOWED VALUE

The following elements in a profile configuration file are assigned a
profilenode value as defined in the following table:
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Types of Profilenodes

Element Profilenode Type and Value
<Profile> « STANDARD PROFILE =1

« RADIO PROFILE =2
 FOLDERED PROFILE = 3

<ProfileFolder> PROFILE FOLDER = 4
<Allowed> ALLOWED VALUE =5
Unrecognized markup INVALID PROFILE =0

The following ACL functions support profiling and allow for site-specific
customizations of Arbortext Editor profiling capabilities. Refer to the Arbortext
Editor online help for detailed descriptions of each function.

Profilenode Functions

profilenode_ancestors (profilenode, arr)

Returns the number of folders that are ancestors of the node identified by the
specified node.

profilenode_attr (profilenode)

Returns the name of the profile attribute for the specified node.
profilenode children nodes (profilenode, arr)

Returns the number of nodes that are children of the specified node.
profilenode_ default value (profilenode)

Returns the default value for a RADIO PROFILE node as specified in the profile
configuration file.

profilenode default value node (profilenode)

Returns the default value profilenode for a RADIO PROFILE node as specified
in the profile configuration file.
profilenode element allowed (profilenode, tagname)

Returns 1 if the element can be profiled using the profilenode.
profilenode_ element attr tests (profilenode, tagname,
arr)

Returns the number of attribute name(s) and value(s) for an element that a
particular profile could be applied to or not applied to.
profilenode_elements list(profilenode, arr, not
indicator)

Returns the number of elements that a particular profile could be applied to or not
applied to.
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profilenode_is foldered (profilenode)

Returns 1 if the root node of the specified node is a FOLDERED PROFILE node.

profilenode is radiochoice (profilenode)

Returns 1 if the root node of the specified node is a RADIO PROFILE node.
profilenode_is_standard (profilenode)

Returns 1 if the root node of the specified node is a STANDARD PROFILE
node.

profilenode name (profilenode)

Returns the profile alias, folder name, or profile value of a profilenode.
profilenode parent (profilenode)

Returns the profilenode of the immediate ancestor of the specified node.
profilenode_rootnode (profilenode)

Returns the top-level or root node for that profile class.
profilenode_ shadingbackground (profilenode)

Returns the shading color for the specified profile node.
profilenode_type (profilenode)

Identifies a profilenode's TYPE.
profilenode valid (profilenode)

Returns 1 if the specified node is a valid profilenode identifier.
profilenode_value nodes (profilenode, arr)

Returns the number of value profilenodes for the specified node.
profilenode_value_ separator (profilenode)

Returns the value separator corresponding to the specified node. The default value

1S a semicolon.
profilenode values (profilenode, arr)

Returns the number of allowed values for the specified node.

Profile Functions
profile_ alias (attr[, doc])

Returns the alias name for the specified profile attribute.
profile aliases (arr[, docl])

Returns the number of profile aliases defined in the current (or other) profiling
configuration file.

profile_allowed (alias, 0id)

Returns 1 if the specified element can be profiled using the specified profile.
Returns 0 if the element cannot be profiled, or if either oid or alias is invalid.
profile attr (alias[, doc])
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Returns the name of the profile attribute for the specified profile.
profile attrs (arr[, doc])

Returns the number of profile attributes defined in the configuration file
associated with the profiling session.
profile_config ([doc])

Returns a document identifier for the current (in-memory) profiling configuration
file.
profile conflictshadingbackground ([doc])

Returns the conflict shading color for the profile for the specified document.
profile default value(alias|[, doc])

Returns the default value for the specified RADIO PROFILE.
profile default value node(alias[, doc])

Returns the default value profilenode for the specified RADIO PROFILE.
profile element allowed(alias, tagname[, doc])

Returns 1 if the specified element can be profiled using the specified profile.
profile_element attr_ tests(alias, tagname, arr([, doc])

Returns the number of attribute name(s) and value(s) for the specified element that
the specified profile can be applied to or not applied to.

profile elements list(alias, arr, not indicator[, doc])

Returns the number of elements the specified profile could be applied to or not
applied to.
profile is foldered (alias[, doc])

Returns 1 if the specified profile class is a FOLDERED PROFILE.
profile_ is radiochoice(alias[, doc])

Returns 1 if the specified profile class is a RADIO PROFILE.
profile is standard (alias[, doc])

Returns 1 if the specified profile class is a STANDARD PROFILE.
profile resolution (oid, logical expression)

Returns 1 if the specified element would be included if the profile was resolved
using the specified logical expression.
profile rootnode (alias[, doc])

Returns the profilenode of type STANDARD PROFILE, RADIO PROFILE, or
FOLDERED PROFILE of a profile class.

profile rootnodes (arr[, doc])

Returns the number of profilenodes of type STANDARD PROFILE, RADIO
PROFILE or FOLDERED PROFILE in the current (or other) profile
configuration file.

profile shadingbackground(alias[, doc])
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Returns the shading color of the profile attribute for the specified alias..
profile type (alias[, doc])

Returns an integer identifying the profile type of the specified alias.
profile valid (alias([, doc])

Returns 1 if the specified alias is a valid profile.
profile value node (alias, value[, doc])

Returns the allowed value profilenode for the specified value in the profile class
identified by the specified alias.
profile value nodes (alias, arr[, doc])

Returns the number of allowed value profilenodes for the profile class identified
by the specified alias.
profile value_ separator(alias[, doc])

Returns the value separator for the specified profile. The default value is a
semicolon.
profile values (alias, arr[, doc])

Returns the number of allowed values for the profile class identified by the
specified alias.

profile values_shadingbackground(alias, arr[, doc[,
IncludeProfileElement]])

Returns the colors for the profile attribute for the specified alias.

Profile Group Functions

apply profile_group (apply profile group name, arrl,
doc])

Returns the number of profile classes that are included in the specified apply
profile group.

apply profile group_ allowed (apply profile group name,
oid, arr/[])

Returns 1 if the profile group apply profile group name, is allowed on the
element oid.

apply profile group value nodes (apply profile group
name, arr|[, doc])

Returns 1 if the specified profile group is allowed on the specified element.
apply profile groups (arr[, doc])

Returns the number of apply profile groups specified in the profile configuration
file.

set profile group (set profile group namel[, doc])

Returns the profile configuration file markup for the specified set profile group
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set_profile groups (arr[, doc])

Returns the number of set profile groups specified in the profile configuration file.
set _profile groups_expressions (arr[, doc])

Returns the number of set profile groups, and the profile classes and relationships
between profile values for the corresponding resolution group specified in the
profiling configuration file.

Profiling DTD Element Reference

The location of the profiling document type definition is Arbortext-path\
doctypes\profiling\profiling.dtd.

Allowed Element

Synopsis

Mixed content model:
Allowed
Empty

Attributes:

value CDATA #REQUIRED

Description

The <A1l1lowed> element specifies the only allowed value for a profile.
The element has no child elements.

The <A1lowed> element has the following attribute:

*  value= CDATA

The allowed value for the parent profile.

ApplyProfileGroup Element

Synopsis

Mixed content model:
ApplyProfileGroup
(ProfileRef) +

Attributes:
name CDATA #REQUIRED

Description

The <ApplyProfileGroup> element specifies a named apply profile group.
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The element can have the following child element:

<ProfileRef>

The <ApplyProfileGroup> element has the following attribute:

name = CDATA

Specifies the name of the profile group.

AttributeTest Element

Synopsis

Mixed content model:
AttributeTest
EMPTY

Attributes:
name CDATA #REQUIRED
value CDATA #IMPLIED

Description

The <AttributeTest> element specifies whether an attribute test must be
performed.

The element has no child elements.

The <AttributeTest> element has the following attributes:

name = CDATA

Specifies the attribute name to test.
value = CDATA

Specifies the value to test for. If value is not specified, and the tested attribute
has any declared value, the test will return TRUE. If value is set to
ATI#UNDECLARED, the test will return TRUE only if the test attribute is
undefined.

LogicalExpression Element

Synopsis

Mixed content model:
LogicalExpression
(LogicalGroup | LogicalNOT)

Attributes:
None
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Description

The <LogicalExpression> element specifies a logical expression to use in a
set profile group.

The element can have the following child elements:
<LogicalGroup>, <LogicalNOT>

The <LogicalExpression> element has no attributes.

LogicalGroup Element

Synopsis

Mixed content model:

LogicalGroup

((ProfileRef | LogicalGroup | LogicalNOT),
(ProfileRef | LogicalGroup | LogicalNOT) +)

Attributes:

operator (AND | OR | XOR | EQUAL) #REQUIRED

Description

The <SetProfileGroup> element defines a logical expression group
The element can have the following child elements:

<ProfileRef>, <LogicalGroup>, <LogicalNOT>

The <LogicalGroup> element has the following attribute:

* operator =AND | OR | XOR | EQUAL

Specifies the logical operator to use. The operators have the following
resolutions when comparing values A and B:

O AND — A logical conjunction. The expression is true if both A and B are
true.

©  OR — A logical disjunction (an inclusive OR). The expression is true if A,
B, or both, are true.

O  XOR — A logical inequivalence (an exclusive OR). The expression is true
if either A or B is true, but false if both A and B are true.
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O EQUAL — A logical equivalence. The expression is true if both A and B
are true, or if both are false.

LogicalNOT Element

Synopsis

Mixed content model:
LogicalNOT
(ProfileRef| LogicalGroup)

Attributes:
None
Description

The <LogicalNOT> element specifies logical negation of an expression. That
is, for value A, the expression is true if A is false and the expression false if A is
true.

The element can have the following child elements:
<ProfileRef>, <LogicalGroup>

The <LogicalNOT> element has no attributes.

NotProfileElement Element

Synopsis

Mixed content model:
NotProfileElement
(AttributeTest*)

Attributes:
element NMTOKEN #REQUIRED
Description

The <NotProfileElement> element defines the elements to be restricted
from having a particular profile.

The element can have the following child element:
<AttributeTest>

The <NotProfileElement> element has the following attribute:
* element = NMTOKEN
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Specifies the name of the element from which the profile is restricted.

Profile Element

Synopsis

Mixed content model:

Profile

((ProfileElement* | NotProfileElement*),
((ProfileFolder | Allowed)+ | RadioChoice))

Attributes:

attribute NMTOKEN #REQUIRED
alias CDATA #REQUIRED
valueSeparator CDATA ";"
Description

The <Profile> element defines the profiles that are available to apply to an
element.

The element can have the following child elements:

<ProfileElement>, <NotProfileElement>, <ProfileFolder>
The <Profile> element has the following attributes:

* attribute = NMTOKEN

Defines the attribute in which to store the profile values. This can be an
attribute value defined in the document type or a namespaced attribute value.

* alias = CDATA
Specifies the name of the profile.
* valueSeparator = CDATA

Specifies the delimiter used to separate multiple profile values specified on a
particular attribute. The default value is a semicolon (; ).

ProfileClasses Element

Synopsis

Mixed content model:
ProfileClasses
((Profile+, ApplyProfileGroup*, SetProfileGroup*))

Attributes:

none
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Description

The <ProfileClasses> element defines the profiles that are available to
apply to an element.

The element can have the following child elements:

<Profile>, <ApplyProfileGroup>,<SetProfileGroup>
The <ProfileClasses> element has no attributes.

* authorModifiable = true | false

Specifies whether the author is allowed to modify the profile during an editing
session.

ProfileElement Element

Synopsis

Mixed content model:
ProfileElement
(AttributeTest*)

Attributes:
element NMTOKEN #REQUIRED
Description

The <ProfileElement> element defines the elements to which the profile is
restricted.

The element can have the following child element:
<AttributeTest>

The <ProfileElement> element has the following attribute:
» element = NMTOKEN

Specifies the name of the element to which the profile is restricted.

ProfileFolder Element

Synopsis

Mixed content model:
ProfileFolder
(ProfileFolder+ | Allowed+)

Attributes:
name CDATA #REQUIRED
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Description

The <ProfileFolder> element specifies the folder structure of a hierarchical
(foldered) profile. Folders can contain folders.

The element can have the following child elements:
<ProfileFolder>,<Allowed>
The <ProfileFolder> element has the following attribute:

* name= CDATA
Specifies the name of the folder.

ProfileRef Element

Synopsis

Mixed content model:
ProfileRef
Empty

Attributes:
alias CDATA #REQUIRED
value CDATA #REQUIRED
Description
The <ProfileRef> element specifies the profile to use in a group.
The element has no child elements.
The <ProfileRef> element has the following attributes:
* alias = CDATA
The alias name associated with the profile being referenced.

*  value= CDATA

The allowed value associated with the profile being referenced.

Profiles Element

Synopsis

Mixed content model:
Profiles
(ProfileClasses+)

Attributes:

none
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Description

The <Profiles> element is a the top-level element of the . pcf file.
The element can have the following child element:
<ProfileClasses>

The <Profiles> element has no attributes.

RadioChoice Element

Synopsis

Mixed content model:
RadioChoice
(Allowed™)

Attributes:
None
Description

The <RadioChoice> element specifies that a profile can only accept one value
from a give list of values.

The element can have the following child element:
<Allowed>

The <RadioChoice> element has no attributes.

SetProfileGroup Element

Synopsis

Mixed content model:
SetProfileGroup
(ProfileRef | LogicalExpression)

Attributes:
name CDATA #REQUIRED
Description

The <SetProfileGroup> element specifies a combination of profile settings
to be used during publishing or resolution.

The element can have the following child elements:
<ProfileRef>, <LogicalExpression>

The <SetProfileGroup> element has the following attribute:
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e name= CDATA

Specifies the name of the set profile group.
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Customizing Tag Help

Tag help is the help that appears when you place the mouse pointer over a tag in
your document and press SHIFT+F1 or Help. Tag help describes the elements
declared in the document type that is being used.

Location of Tag Help Files

Tag help files are stored in a \he1p subdirectory of a document type's directory
in Arbortext-path\doctypes. Arbortext-path is the directory where
Arbortext Editor is installed. The doctypes directory in Arbortext-path in
turn contains directories for the individual distributed document types. Each of
those directories has a \he1p subdirectory.

As an illustration, if Arbortext Editor resides in the directory c: \Program
Files\PTC Arbortext\Editor, tag help for a document type would reside
inc:\Program Files\PTC Arbortext\Editor\doctypes\dtddir\
help, where dtddi r is the name of the directory containing a particular
document type.

More specifically, if your document type is a customized document type installed
in the directory c: \apps\doctypes\mydoc, the document type’s tag help
files will be stored in c: \apps\doctypes\mydoc\help.

Tag Help File Types

To create and modify help for element tags using Arbortext Editor, create and save
the text for each tag in a separate file, typically using the same document type as
that which the help supports. If the document type does not easily support text
elements, PTC recommends using a document type such as XHTML.

For example, create help files supporting the memo SGML document type using
the memo SGML document type. Create help files supporting the ATT XML
DocBook document type using the ATT XML DocBook document type.

Creating Tag Help for a New Document Type
Use the following steps for creating tag help for a new document type.

1. Create a new document using the same document type as you are
documenting. If the document type does not easily support text elements, use a
document type such as XHTML.

2. Author your help text for a given tag. Use a separate file for each individual
tag's help.

3. Save the document to the help subdirectory for your document type with the
tag name as the file name and the appropriate extension for the document type.
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For example, if you author a help file for an element body using the memo
document type, save it in a file named body . sgm. If you author a help file
for an element sect1 using the ATI XML DocBook document type, save it in
a file named sectl1.xml

Save the file in the he 1p subdirectory of doctypedir, where doctypedir is the
directory where the document type resides.

Test the help file for a tag in a document based on that document type. Place
the mouse pointer over the tag for which you've created help, and press SHIFT
+F1. The new tag help is displayed.

Customizing Tag Help for an Existing Document Type

Use the following procedure to customize tag help for an existing document type,
such as a document type delivered with Arbortext Editor.

I.

Set the environment variable APTHELPPATH to specify a directory in which
you will store the custom help files.

Copy the existing tag help files to this new directory.
Use Arbortext Editor to update the copies of the files as necessary.

Test your customized help by placing the mouse pointer over a tag and
pressing SHIFT+F1. The customized tag help is displayed.
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PDF Publishing Overview

There are several ways in which you can create PDF files with Arbortext Editor
and Arbortext Styler or Arbortext Publishing Engine:

* With the PTC APP publishing engine, you can publish PDF directly from an
XML file or generate from intermediate PostScript source.

+  With the FOSI publishing engine, you can publish PDF directly from an XML
file.

~ Note

The FOSI and XSL-FO print engines are on sustained support and do not
receive enhancements or maintenance fixes. PTC APP is the recommended
engine for print output.

See Choosing PDF Configuration Options on page 62 for information about how
to set configuration choices.

See Publishing Engine Overview and Print and PDF Configuration Files in
Arbortext Editor help for an explanation of print engines and PDF configuration
files.

Using PTC APP Publishing Engine for
PDF

You may publish PDF or PostScript output. Separate configuration files support
these actions.

For information about PDF configuration files supported by the PTC APP print
engine, please refer to PDF Configuration Files for PTC APP on page 63

Using FOSI Publishing Engine for PDF

You can publish PDF with the FOSI publishing engine by sending publishing
requests to Arbortext Publishing Engine and specifying the FOSI print engine in
the stylesheet, by having Arbortext Styler running with Arbortext Editor, or by
having a Print Composer license on Arbortext Editor.
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~ Note

The FOSI and XSL-FO print engines are on sustained support and do not
receive enhancements or maintenance fixes. PTC APP is the recommended
engine for print output.

Watermarks

Watermarks can underlay output pages for formatting, printing, or publishing a
PDF. The methods for specifying watermarks for PDF differ between the PTC
Advanced Print Publisher and FOSI engines.

Watermarks when Publishing with PTC APP

In Arbortext Styler, you may create a page region that holds text or a graphic, and
set it to underlay the main content region of a page. Refer to Defining Page
Regions in Arbortext Styler help for information on creating regions for a page
set.

Watermarks when Publishing with FOSI

Set the APTWATERMARKTEXT environment variable to the value you want to
appear as the watermark text. Refer to the APTWATERMARKTEXT online help
topic for information on using it.

Creating PDF Bookmarks Using Arbortext
Styler

PDF bookmarks created in this way are supported in PDF output generated by the
PTC APP, FOSI, and XSL-FO publishing engines.

In Arbortext Styler, you can elect to generate a table of contents (TOC) whose
entries will form the bookmarks in your PDF. This can be separate from the main
table of contents for the document if required and be configured to include your
own set of entries. Refer to Table of Contents Overview in Arbortext Styler help
for information.

Creating PDF Bookmarks Using FOSI

You can create bookmarks using markup illustrated in the following example in
your stylesheet.
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You can open the PDF to the first page, open the bookmark panel, and scale the
page to fit in the window by placing the following anywhere in a document (or in
a FOSI that places it anywhere in the document) using the following
atidmd:DocView example:
<atidmd:DocumentMetaData source="atend">

<atidmd:DocView bookmarks="auto" mode="bookmarks"

fit="fitPage" destination="">

</atidmd:DocView>
</atidmd:DocumentMetaData>

The destination attribute defaults to the page on which the
atidmd:DocView tag appears. If a valid named destination name is placed in
the destination attribute, the document will open at the page on which the
named destination appears. A named destination can be created by inserting a link
target at the desired point in the document, or adding an ID to a tag at that
location.

~ Note

If DocView is specified in the stylesheet, it takes priority over the
destination attribute value.

You can also generate an atidmd:DocumentMetaData node at the beginning of a
document with a source="atend” attribute, and also an atidmd:
DocumentMetaData node at the end of the root node content. Have the FOSI
produce the following at beginning of the document, which has the effect of
disabling automatic bookmarks:
<atidmd:DocumentMetaData source="atend">
<atidmd:DocView mode="bookmarks" fit="fitPage" destination="">
</atidmd:DocView></para>
</atidmd:DocumentMetaData>

Then have the FOSI produce the following at the end of document:
<atidmd:DocumentMetaData>

<atidmd:Outline>

<atidmd:Bookmark>

<atidmd:Title>Book title</atidmd:Title>
<atidmd:Bookmark>

<atidmd:Title>Chapter 1 Title</atidmd:Title>
</atidmd:Bookmark>

<atidmd:Bookmark>

<atidmd:Title>Chapter 2 Title</atidmd:Title>
</atidmd:Bookmark>

</atidmd:Bookmark>

<atidmd:Bookmark state="closed">
<atidmd:Title>List of Figures</atidmd:Title>
<atidmd:Bookmark>

<atidmd:Title>Figure 1</atidmd:Title>

60 Customizer's Guide



</atidmd:Bookmark>

<atidmd:Bookmark>
<atidmd:Title>Figure 2</atidmd:Title>
</atidmd:Bookmark>

</atidmd:Bookmark>

</atidmd:Outline>
</atidmd:DocumentMetaData>

The text variables used for links (such as bookmarks. txt in the following

example) must be declared hotlinks to provide the bookmark destination using the

_gtlink PI.

<stringdecl textid="docinfo.txt">

<stringdecl textid="chapter-bookmarks.txt" hotlink="1">

<stringdecl textid="book-title.txt">

<stringdecl textid="bookmarks.txt" hotlink="1">

<stringdecl textid="figures.bookmark.txt" hotlink="1">

Book eic:

<usetext source='!<atidmd:DocumentMetaData source="atend"></atidmd:DocumentMetaD
placemnt="before"></usetext>

<savetext textid="chapter-bookmarks.txt" placemnt="before" conrule="\\">

<savetext textid="bookmarks.txt" placemnt="after"
conrule="!<atidmd:Bookmark><atidmd:Title>!,book-title.txt, !</atidmd:Title>!,
chapter-bookmarks.txt, !</atidmd:Bookmark>!"'>

<usetext source='!<atidmd:DocumentMetaData><atidmd:DocInfo>!,docinfo.txt, !</atidm
<atidmd:Outline>!,bookmarks. txt,
!<atidmd:Bookmark state="closed"><atidmd:Title>List of Figures</atidmd:Title>!,f
!</atidmd:Bookmark></atidmd:Outline></atidmd:DocumentMetaData>!"
placemnt="after"></usetext>

~ Note

The Arbortext Document Metadata namespace description is available from
the Arbortext web site:

www.arbortext.com/namespace/DocumentMetaData/

The Arbortext XSL FO Extensions namespace description is available from
the Arbortext web site:

www.arbortext.com/namespace/XslFoExtensions/
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Creating Document Properties

With Arbortext Styler

For information on how to define standard or user-defined metadata and document
properties for a PDF file in your Arbortext Styler stylesheet, refer to Passing
Metadata to PDF Output in Arbortext Styler help.

Metadata definitions in the . style file are supported in all print and PDF
outputs — PTC APP, FOSI, and XSL-FO.

With FOSI

You can generate document properties for the PDF by placing FOSI information
anywhere in a document (or in a FOSI that places it anywhere in the document).
An example showing the use of atidmd: DocInfo is given below:
<atidmd:DocumentMetaData>
<atidmd:DocInfo>
<atidmd:Entry>
<atidmd:Key>Title</atidmd:Key><atidmd:Value>Moby Dick</atidmd:Value>
</atidmd:Entry>
<atidmd:Entry>
<atidmd:Key>Author</atidmd:Key><atidmd:Value>Herman Melville</atidmd:Value>
</atidmd:Entry>
</atidmd:DocInfo>
<atidmd:DocumentMetaData></para>

Choosing PDF Configuration Options

When Arbortext Editor and Arbortext Publishing Engine publish PDF files, they
use an XML configuration file (a . appcf for PTC APP, a . pdfcf file for
FOSI) to specify PDF options.

When publishing PDF, you can choose a PDF configuration file by:
* choosing a PDF configuration file in the Publish PDF File dialog box.

* specifying a default PDF configuration file using the set pdfconfigfile
command (documented in the Arbortext Command Language Reference).

You can use or modify one of the PDF configuration files distributed with
Arbortext Editor and Arbortext Publishing Engine or create a custom PDF
configuration file.
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~ Note

The FOSI and XSL-FO print engines are on sustained support and do not
receive enhancements or maintenance fixes. PTC APP is the recommended
engine for print output.

PDF Configuration Files for PTC APP

The distributed configuration files are:
* Arbortext-path\app\standard.appct
Supports publishing of PDF
* Arbortext-path\app\postscript.appcf
Supports printing to a PostScript printer and generating a PostScript file

You can save a custom version of files if you wish to tailor your own PDF
publishing process/output. Open the file in Arbortext Editor (without a stylesheet),
make changes, then save the custom file, with the same file extension, in any of
these locations:

* Publishing PDF from Arbortext Editor or Arbortext Styler — you can browse
for a custom file, or locate it in the APTCUSTOM\ app directory where PTC
APP will find it

» Publishing PDF via Arbortext Publishing Engine — a custom file must be
located on the PE server, in any of these locations:

O Arbortext-path\app
O any APTCUSTOM\ app directory

O an application or custom doctype\ nnn directory, where nnn is the short
doctype name of the doctype of the document being published.

Custom . appcf files must contain a single Print and a single Format
element, although these do not require child elements to be valid.

See PDF Configuration File for the APP Engine (.appcf) in the User's Guide to
Arbortext Styler and Print and PDF Configuration Files in Arbortext Editor help
for information about custom configuration files.

PDF Configuration Files for FOSI

The distributed configuration files are:

* Arbortext-path\lib\standard.pdfcf
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This is the default PDF configuration file and configures the PDF file for
general use. Embedding is turned on but also specifies a NeverEmbed list of
the core 14 fonts.

Compression is set to AUTO (choose the smaller of JPEG or ZIP
compression).

The target raster image resolution is 600 DPI for raster images exceeding the
threshold of 900 DPI.

Arbortext-path\lib\screen.pdfcft

Configures the PDF file for screen display, with embedding turned on but also
specifies a NeverEmbed list of the core 14 fonts.

Compression is set to JPEG.

The target raster image resolution is 300 DPI for raster images exceeding the
threshold of 450 DPI.

Arbortext-path\lib\print.pdfcf

Optimizes PDF file for printing, with embedding turned on but also a
NeverEmbed list of the core 14 fonts.

Compression is set to ZIP (the default).

The target raster image resolution is 1200 DPI for raster images exceeding the
threshold of 1800 DPI.

Arbortext-path\lib\smallfile.pdfcf
Turns off embedding.
Compression is set to JPEG.

The target raster image resolution is 200 DPI for raster images exceeding the
threshold of 300 DPI.

Note

PDF configuration files are distributed by locale and are located in
Arbortext-path\lib\locale\lang, where 1ang is the locale name.

You can create a custom PDF configuration file (custom-file-
name.pdfcf)and putitin Arbortext-path\custom\1lib, where it will
be automatically accessible when Arbortext Editor or Arbortext Publishing Engine
starts. You can also put a set pdfconfigfile statement in a custom ACL file
placed in Arbortext-path\custom\init\custom-file-name.acl,
where it will be loaded at start time.
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The structure and content of the . pdfcf PDF configuration file is explained in
PDF DTD Element Usage (FOSI) on page 70 and the sections that follow it.

Linking Between PDF Files

The procedures that follow show how to link from a PDF to a page number and a
named destination in another PDF file.

~ Note

Linking to a page number or named destination only applies when publishing
to PDF directly from XML using Arbortext Publishing Engine.

To Link to a Page Number in the Target PDF

1. In Arbortext Editor, choose Insert » Link/Xref and choose Browse the Web in
the Resource Manager.If you are working in a non-DITA document, the menu
option will be Insert » Link, followed by Web.

2. Insert a URL that specifies the PDF file (the URL must include . pdf)
followed by #page= and the page number (for example,
mydoc.pdf#page=30).

3. Click the Insert button.

To Link to a Named Destination in the Target PDF

If the target is on an element that is also included in the table of contents, such as a
Title tag, the link will target the table of contents instead of the location in the
document. The two anchors have the same name, and only the first is recognized.

1. In the target document, select the element that will be the target of the link and
give it an ID attribute, for example mytarget.If you are working in a non-
DITA document, you can also use Insert » Link Target to insert the ID.

2. In the source document, choose Insert » Link/Xref and choose Browse the Web
in the Resource Manager. If you are working in a non-DITA document, the
menu option will be Insert » Link, followed by Web.

3. Insert a URL that specifies the PDF file (the URL must include . pdf)
followed by #nameddest= and the link target name (for example,
mydoc.pdf#nameddest=mytarget).

4. Click the Insert button.
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Configuring Security Options

If you want to apply security options to PDF files you create, you need to modify
the PDF configuration file to specify the security options.

Security Options for PTC APP Publishing

1. Make a copy of a PDF configuration file (you can choose
standard.appcf from Arbortext-path\app).

2. Save the copy of the file to APTCUSTOM\ app.

3. The Security element in the . appcft file includes options for configuring
document protection. Add this element hierarchy to the required Print
element: Print PDFPrinter Security

4. Use the attributes of the Security element to set security for your output
PDF. For example, set the value of the userPassword or masterPassword
attributes to the required string to provide password protection.

Save the file.

When publishing your PDF with the PTC APP engine, select your custom
configuration file in the Config File field of the Publish to PDF File dialog box.

Security Options for FOSI Publishing
PDF security options are explained in Security Element on page 80.

1. Make a copy of a PDF configuration file (you can choose a . pdfcf from
Arbortext-path\1lib).

2. Open Arbortext Architect, and choose Edit » PDFCF. Open your . pdfcf file.
3. Locate the Security element, and choose Edit » Modify Attributes.

4. Type a password as the userPassword. This restricts access to the PDF file to
users who have the userPassword.

5. Type another password as the masterPassword if you plan to set any of the
other security settings in the Modify Attributes dialog box to yes. For example,

you can set noPrint to yes to prevent users from printing the PDF file or set
noModify to yes to prevent users from modifying the PDF file.

6. Click OK to exit the Modify Attributes dialog box.

7. Choose File » Save, and then File » Close to exit Arbortext Architect.

8. Place the . pdfcf file in the custom\1ib directory in the install tree.
9. Start Arbortext Editor and open a document.

10. Choose File » Publish » PDF File.
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11. If you put your . pdfcf file in the custom\ 1ib, you can select it from the
Configuration File list .

12. Leave View PDF File selected, and then click OK.

13. When Adobe Acrobat opens the document, a prompt indicates that the file is

protected and asks for a password. Type the password you set as the
userPassword into the Password field. When the document opens, you can

check that you are unable to perform the actions you prevented in the . pdfcf
file. For example, if you set noModify to yes, the menu options for Cut, Copy,
and Delete arc unavailable.

Adding Fonts Used by Graphics

In .eps, .drw, and . cgm graphic formats, it's possible that a font within these
files may not appear in PDF output, even though the graphic file has a properly
defined font. There are three approaches for handling fonts within graphics:

* Confine fonts used in these graphics to the basic PDF 14 (Helvetica, Courier,
Times-Roman, Symbol, and their variants), which are handled correctly.

* For fonts other than the basic PDF 14, embed the fonts in your .eps, .drw,
and . cgm file . Embedded fonts are also handled correctly.

* For fonts other than the basic 14 that can't be embedded, use the procedure for
font configuration that follows.

If working with the PTC APP engine, make the required changes in
Arbortext-path\pstill.

If working with the FOSI engine, you can copy the Arbortext-path\
pstill directory to another location before making changes. If you do, set
the APTPSTILLPATH environment variable to the path of the alternate
location.

To Add PFA or PFB Fonts

1. In a command prompt window, navigate to the Arbortext-path\pstill
directory.

2. Run the batch file SetPath.bat in the command window, from this
directory. This file extracts the path to this \psti11 directory.

3. Ifyou have copied the \pstil1l directory elsewhere, navigate to that
location.

4. Run instfonts.exe from the same command window as you ran
SetPath.bat.

5. To add fonts, place PFA or PFB files in the PSFonts subdirectory. Then
update the font files by entering:
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instfonts UPDATE
The script updates the special font files used by PStill.

You can install a TTF file if it's not protected against conversion. Check your font
license to see if it is allowed.

To Add TTF Fonts:

1. In a command prompt window, navigate to the Arbortext-path\pstill
directory.

2. Run the batch file SetPath.bat in the command window, from this
directory. This file extracts the path to this \psti11 directory.

3. Ifyou have copied the \pstill directory elsewhere, navigate to that
location.

4. Run instfonts.exe from the same command window as you ran
SetPath.bat.

5. Install a TTF font by entering:
instfonts TTFFULLINSTALL full-path-to-TTF-file postscript-name

or, you can enter:
instfonts TTFINSTALL full-path-to-TTF-file postscript-name
instfonts UPDATE

The PostScript name is the name referenced in the . eps, .drw, or . cgm file.
The name is case-sensitive.

To Create Fonts for the Basic 14 PDF Fonts:
1. Ina command prompt window, navigate to the Arbortext-path\pstill
directory.

2. Run the batch file SetPath.bat in the command window, from this
directory. This file extracts the path to this \psti11 directory.

3. Ifyou have copied the \pstil1l directory elsewhere, navigate to that
location.

4. Run instfonts.exe from the same command window as you ran
SetPath.bat.

5. Create font files for the basic PDF 14 fonts by entering:
instfonts CREATE

Configuring Fonts for FOSI Publishing

The Font element in the PDF configuration file lets you configure font locations,
map . t fm file names to fonts, and enable font substitutions, embedding, and
subsets. Consult the PDF DTD Element Usage (FOSI) on page 70 for detailed
information on the elements and their attributes.

68 Customizer's Guide



Arbortext Command Language and the Arbortext Publishing Engine use font
metrics to lay out the text of a document into paragraphs and pages. However, a
real font is necessary for rendering the page. A real font is a raster or vector font.
A raster font (a . pk file) contains pixels for all characters in the font rasterized to
a particular resolution. A vector font (a type 1 or true type font) contains
instructions for drawing the character outlines.

The FontName element specifies real fonts. These font names may contain
Unicode characters. The FontName element has a select attribute that sets the
data condition for a particular operating system. If you use select, the value
must match one of the tokens generated by the application (for example
Windows), called the selection criteria. A select attribute may include more
than one token. If any of them is equal to any of the selection criteria tokens, then
the FontName matches. If a select attribute is empty or not present, then a
match is assumed. The encoding attribute specifies the encoding to use with the
specified font. Eight-bit and multi-byte formats are supported.

The FontName element can name a system font or a font outline file (TTF, PFA,
or PFB). The type of file is specified in the t ype attribute, and the path and file
name is specified in the path attribute. If the type is SYS, the path is ignored. If
path contains a relative path, the search is relative to the custom\ fonts
subdirectory. The contents of the FontName tag for a font outline file should be
the name of the font as represented in the outline file.

The FontName element has a simulate attribute that can specify the kind of
simulation (such as bold or italic) to apply to the font. The simulateMode
attribute specifies how to apply the simulation, either by modifying the font
display within the PDF (by displaying characters at an angle for italic or through
multiple registrations for bold) or by setting a flag that tells the PDF viewer to
render the simulation.

The Map element associates the name of a . t fm file with a font. Multiple real
fonts may be listed, but Arbortext Editor and Arbortext Publishing Engine use
only the first match. This allows the select attribute to determine which font is
used on a given platform.

For fonts that are not specified in FontName, are not mapped in this file, and do
not have the specified font face available, you can use the Simulation
elements Bold and Ttalics to simulate bold and italic faces. Use simulated
bold, italic, and bold-italic font styles for CJK fonts and Arial Unicode MS, which
don't have bold or italic faces.

The Locations element can specify directories where the direct PDF process
searches for font files.

The FontPath element specifies PK raster font files. The dp1i attribute specifies
the resolution of the fonts. The contents of the element are the path to the . pk file
relative to the pixels directory.
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You can specify Substitute to use a different font in the PDF file than was
used in the original file. The substitute font must have the same font metrics as the
original font. Arbortext Editor and Arbortext Publishing Engine use the first
replacement that matches the selection criteria.

Embedding lets you select the fonts that are embedded or prevent embedding in
the PDF file. The subsetting attribute allows you to control whether to embed
the whole font or just the characters needed by the PDF file.

PDF DTD Element Usage (FOSI)

FOSI publishing supports the elements described in the following sections for
configuring PDF options. The document type for FOSI PDF configuration files

(.pdfcf)is located at:
Arbortext-path\doctypes\pdfconfig\pdfconfig.dtd

The elements are organized according to the hierarchy within the DTD.

Pdfconfig Document Type
The <Pdfconfig> document type is a PDF configuration XML document.

The <Pdfconfig> document type can have the following child elements:

Child elements of Pdfconfig

General Element Optional
on page 70
Color Element Optional
on page 82
Font Element Optional
on page 84
Documentation Element Optional
on page 97
Label Element Optional
on page 97

General Element

The <General> element controls a variety of aspects of the PDF file.
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The <General> element has the following child elements:

Child elements of General

Annotations Element
on page 71

Optional and may be used once

Compatibility Element
on page 72

Optional and may be used once

Compression Element
on page 73

Optional and may be used once

Cropmarks Element
on page 74

Optional and may be used once

Docinfo Element
on page 75

Optional and may be used once

Images Element
on page 76

Optional and may be used once

Merge Element
on page 77

Optional and may be used once

Open Element
on page 78

Optional and may be used once

Security Element
on page 80

Optional and may be used once

The <General> element has one attribute, f i xupPageSizes =yes | no. If
set to yes, it reconciles differences in page size between the front and back of a
sheet. The height will be the larger of the two page heights and the width will be
the larger of the two page widths. The default is no.

If a page dimension is increased, the content of the page will be centered within
that dimension. Page dimensions are never decreased.

Annotations Element

The <Annotations> element controls the display f bookmarks, links, and other
features in the PDF file. It’s optional and may be used once.

The <Annotations> element has no child elements.

The <Annotations> element has the following attributes:
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Attributes of Annotations

Attribute and values Description

enabled = yes | no Allows you to turn off PDF features that
aren't relevant for printing, such as
bookmarks and links. The default is yes.

nameddestToPage = yes | no Setting to yes converts named
destinations to page numbers in PDF links.

Compatibility Element

The <Compatibility> element specifies the type of PDF file that is produced.
It’s optional and may be used once.

The <Compatibility> element may have either a <PDF> or <PDFX> child
element.

The <Compatibility> element has no attributes.

PDF Element
The <PDF> element specifies the version of the PDF file.
The <PDF> element has no child elements.

The <PDF> element has one attribute, leve/=1.3|1.4|1.5| 1.6. The default
is 1.4. PDF versions 1.3, 1.4, 1.5, 1.6, and 1.7 are supported by Adobe Acrobat
4.0, 5.0, 6.0, 7.0, and 8.0 respectively.

PDFX Element

The <PDFX> element specifies the PDF/X standards series, which provides a
consistent and robust subset of PDF which can be used to deliver data suitable for
commercial printing. The driver can generate output conforming to the following
variations of PDF/X:

* PDF/X-1 and PDF/X-1a, both defined in ISO 15930-1:2001
+ PDF/X-3 as defined in ISO 15930-3:2002

PDF/X is specified using the <PDFX> tag within the <Compatibility> tag. If
you specify <PDFX>, you need to set the enabled attribute of the
<Annotations> element to no.
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~ Note

PDF /X support is offered as a technology preview. No guarantees are made as
to the correctness or usability of output using the PDF/X options.

For more information on using PDF /X, refer to PDF/X Frequently Asked

Questions available from:

http://www.adobe.com/enterprise/pdfs/acr6 _pdfx faq.pdf

The <PDFX> element has no child elements.

Attributes of PDFX

Attribute and values

Description

level=1:2001]1a:2001 |
1a:2003(2:2003]3:2002 |
3:2003

settings beginning with 1 specify PDF/X-
1, settings beginning with 1a specify
PDF/X-1a, and settings beginning with 3
specify PDF/X-3. The defaultis 3:2003.

outputlntent = CDATA

Specifies the rendering intent.

defaultRGB = CDATA

Specifies the ICC profile for converting
RGB images, text, and graphics.

defaultGray = CDATA

Specifies the ICC profile for converting
Gray images, text, and graphics.

defaultCMYK = CDATA

Specifies the ICC profile for converting
CMYK images, text, and graphics.

Compression Element

The <Compression> element specifies the type and level of compression. It’s

optional and may be used once.

The <Compression> element has no child elements.

The <Compression> element has the following attributes:
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Attributes of Compression

Attribute and values Description

level = NMTOKEN Specifies the ZIP compression level, which
you can set from 0 (none) to 9 (maximum).
The default is 6. This attribute is ignored if
type = JPEG.

quality = NMTOKEN Specifies the JPEG quality, which you can
set from 1 (lowest) to 100 (highest). The
default is 80. This attribute is ignored if
type = Z1P.

type=7Z1P | JPEG|AUTO Specifies the kind of compression. AUTO
chooses whichever is smaller between ZIP
and JPEG. The defaultis ZIP.

Cropmarks Element

The <Cropmarks> element specifies the characteristics of crop marks and whether
they appear in the PDF output. It’s optional and may be used once.

The <Cropmarks> element has no child elements.

The <Cropmarks> element has the following attributes:

Attributes of Cropmarks
Attribute and values Description
enabled = yes | no Specifies whether to display crop marks in
the output. The default is yes.
pageDims = absolute | When set to absolute, uses the values
increment set by pageWidth and pageHeight for the

output page dimension. When set to
increment, pageWidth and pageHeight
are added to the input page dimension to
get the output page dimension. The default
is increment.

pageWidth = CDATA Specify an integer as the output page
width in points; used as input for
pageDims to determine the page
dimension. The default is 144, which is
the equivalent of 2 inches.

pageHeight = CDATA Specify an integer as the output page
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Attributes of Cropmarks (continued)

Attribute and values

Description

height in points; used as input for
pageDims to determine the page
dimension. The default is 144, which is
the equivalent of 2 inches.

gap = CDATA

Specify an integer as the distance in points
from the corners of content to each crop
mark. The default is 4.

thickness = CDATA

Specify an integer as the rule thickness in
points for the crop mark. Decimal values
are allowed. The default is . 25.

length = CDATA

Specify an integer as the size in points for
the length of the crop mark. The default is
36.

placement = center | upperLeft
| upperRight | lowerLeft |
lowerRight |useOffsets

Specifies where the page content is placed.
Specitying useOf fsets positions the
upper left corner of the contents
x0ffset points down from top of page
and yOf fset points from the left. The
default is center, which centers the
content on the page.

xOffset = CDATA

Specifies the vertical distance in points for
placing the upper left corner of content.
This value is ignored unless placement =
useOffsets.

yOffset = CDATA

Specifies the horizontal distance in points
for placing the upper left corner of
content. This value is ignored unless
placement = useOffsets.

Docinfo Element

The <Docinfo> element specifies document properties in the PDF being
created. It’s optional and may be used once.

The <Docinfo> element has one required child element, <Entry>, which
specifies the document property names and their values.

The <Docinfo> element has no attributes.
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Entry Element

The <Entry> element specifies the document properties that can be set when the
PDF is created. <Entry> is required and repeatable.

The <Entry> element has no child elements.

The <Entry> element has the following attributes:

Attributes of the Entry element

Attributes and values Description

key = CDATA Specifies the document property name. A
key is case-sensitive (i.e. Title, not title).
Key names and values are associated with
the Title, Author, Subject, and Keywords
fields of Document Properties. Other
names and values will be displayed on the
Custom tab of Document Properties for
the PDF.

value = CDATA Specifies the document property value.

Images Element

The <Images> element specifies how graphics are handled in the PDF file. It’s
optional and may be used once.

The <Images> element has one optional child element, <DownSample>.

The <Images> element has two attributes:

Attributes of the Images element

Attribute and values Description

passthrough =omp | BMP | gif | specifies the graphic types to be passed

GIF|jpg| JPG| jpeg| JPEG | through to the PDF document without

png | PNG | tif |TIF | tiff | processing (as long as cropping is not

TIFF required).

rasterize = cgm | CGM specifies the graphic type to be rasterized.
Currently only supports CGM graphics.
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DownSample Element

The <DownSample> element controls how raster images are handled. It’s
optional and may be used once.

The <DownSample> element has no child elements.

The <DownSample> element has the following attributes and values:

Attributes of the DownSample element

Attribute and values Description

targetDpi = NMTOKEN Specifies the dots per inch (DPI) that a
graphic's resolution will be reduced to
when its resolution is larger than the value
specified by the threshold attribute.
threshold = NMTOKEN When a graphic's resolution is larger than
the specified value, the resolution of the
graphic is reduced to the targetDpi
value.

Merge Element

The <Merge> element allows inserting existing PDFs into the PDF being
created. It’s optional and may be used once.

The <Merge> element has one required child element, <Insert>, which
specifies the insertion instructions.

The <Merge> element has no attributes.

Insert Element

The <Insert> element specifies the instructions for inserting existing PDFs into
the PDF being created. By default, PDFs are inserted on a recto page with even
padding at the end of the document. If no destination or placement is provided,
then the PDF will be inserted after the entire document that is being published to
PDF. <Insert> is required and repeatable.

The <Insert> element has no child elements.

The <Insert> element has the following attributes:
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Attributes of the Insert element

Attribute and values

Description

path = CDATA

Specifies the path and file name of the
PDF document to insert.

start = recto | verso | none

Specifies the page layout position for
inserting the PDF. The default is recto.

pad=even | odd | none

Specifies the padding to use to complete
the inserted section.

destination = CDATA

Specifies the target destination within the
PDF where the referenced PDF should be
inserted.

placement =before |after

Specifies whether to place an inserted PDF
before or after the entire document.

Open Element

The <Open> element controls the characteristics of the PDF file when it is
opened. It’s optional and may be used once.

The <Open> element has no child elements.

The <Open> element has the following attributes:

Attributes of the Open element

Attribute and values

Description

mode = none | bookmarks |
thumbnails | fullscreen

Specifies a method for displaying the
document, including settings for the
navigation pane. The default is none.

fit=fitPage | fitWidth |
actualSize

Specifies the initial magnification view in
the PDF viewer relative to its display area.
fit is ignored if mode is fullscreen.
fitPage displays the entire page in the
window. £itWidth displays the page
scaled to the width of the window.
actualSize displays the page at 100%.
The default is fitPage.

destination = CDATA

Specifies the page displayed when the
document is opened. Specify a named
destination or a page number. A page
number must be preceded by page=. The
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Attributes of the Open element (continued)

Attribute and values

Description

default is the first page.

displayTitle = yes | no

By default, Adobe Acrobat displays the
PDF file name in the title bar. If
displayTitle is set to yes, Acrobat will
display the document title instead.

pageLayout =default | single |
twoup

Setting pageLayout to default displays
the document according to Acrobat's
settings for opening a document. Setting
pageLayout to single displays a single
page when the document is opened.
Setting pageLayout to twoup displays
two pages side-by-side when the
document is opened. The default is
single.

continuous = yes | no

The setting of continuous is ignored if
pageLayout 1s set to default. Otherwise, if
continuous is set to no, only a single page
or pair of pages will be shown at any
given time. Scrolling to the bottom will
cause an abrupt change to the next page or
pages. If set to yes, the page transitions
will be shown. For PDF versions 1.4 or
lower, continuous=no is not supported for
pagelLayout=twoup.

facing = yes | no

The setting of facing is ignored unless
pageLayout is set to twoup. Otherwise, if
facing is no, the document will be
displayed starting with the first page on
the left. Each pair of pages will be the
recto and verso of a sheet. If facing is
yes, the first page will appear by itself
and subsequent pairs of pages will be the
verso of one page and the recto of the next

page.

Use the following guidelines:
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Setting pagelLayout=de fault ignores the other settings.

For a single page non-scrolling view, use pageLayout=single and
continuous=no (ignores facing).

For a single page scrolling view, use pageLayout=single and continuous
=yes (ignores facing).

For a two page scrolling view that starts with first page on the left side, use
pageLayout=twoup, continuous=yes, and facing=no.

For a two page scrolling view that starts with first page on the right side and
then continues with facing pages, use pageLayout=twoup, continuous=yes,
and facing=vyes.

For a two page non-scrolling view that starts with the first page on the left
side, use pageLayout=twoup, continuous=no, and facing=no.

For a two page non-scrolling view that starts with the first page on the right
side and then continues with facing pages, use pagelLayout=twoup,
continuous=no, and facing=yes.

Security Element

The <Security> element limits access to the PDF file. It’s optional and may be
used once.

The <Security> element has no child elements.

The <Security> element has the following attributes and values:

Attributes of the Security element

Attribute and values Description

userPassword = CDATA Specifies a user password that is needed to

view the PDF file.

~ Note

When using a password, the PDF file is
encoded using 128-bit encryption (40-
bit encryption when 1.3 compatibility
is used).

masterPassword = CDATA Specifies a password to override security

restrictions (noPrint, noModify, noCopy,
noAnnots, noForms, noAccessible,
noAssemble, noHiresPrint) that are applied
when the PDF file is created This
password must be different than the user
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Attributes of the Security element (continued)

Attribute and values

Description

password.

noPrint = yes | no

When set to yes, prevents printing of the
PDF file. You must also specify a
masterPassword when this attribute is set
to yes.

noModify = yes | no

When set to yes, prevents modifying of
the PDF file. You must also specify a
masterPassword whe